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Welcome 
 
The TFG4000 Software Series is a set of business management software applications that 
offer the robust functionality of an advanced management tool, yet tailored to meet the 
needs and budget of your growing business.  Even better – every application in the 
TFG4000 Software Series is sold separately as a stand-alone product, which means you buy 
only what you need to run your operation more efficiently.  For example, companies that 
only need to track and manage inventory are not forced to navigate through a multitude of 
unnecessary screens, but rather access the specific application that they need to perform 
their business operation.  The added bonus of having every application in the TFG4000 
Software Series is that each product recognizes the others and runs in harmony to provide 
you the optimum benefit of business management software. 
 
TFG4000 is an easy-to-learn, user-friendly system that requires only minimal keystrokes for 
entering information.  There are customizable dropdowns, font sizes, and screen colors 
available within the applications, as well as powerful search capabilities and built-in help 
features to help guide you through the system.  With TFG4000, you have the ability to pull 
up various summary screens, enter as little or as much data as you need, process a variety 
of reports - all of which help you save both time and money, which will add directly to your 
bottom line.  For added convenience, TFG4000 also allows you to run the system in either 
single or multi-user mode, whichever works best for your business.  Other features include 
optional security, as well as data import and export features, which save you the work of re-
keying information.  In all, TFG4000™ is the smart source for business management.  A 
simple solution for a complex process. 
 
 

System Requirements 
 
Microsoft® Windows® 98, Windows NT® 4.0, Windows® 2000, Windows® ME, or Windows 
XP®, with the latest Service Pack applied. 
 
Pentium® class processor, 350mhz or greater. 
 
90MB free disk space. 
 
128MB of RAM (256MB recommended). 
 
Network Interface Card configured to use TCP/IP if installing in multiple user mode (client / 
server
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Starting TFG4000 
 
Perform the following steps to start TFG4000 in either Single or Multiple User Mode: 
 
 Single User 
 
 1. Open the “Start” menu, and then select the “Program” option. 
 
 2. Select “TFG4000 V1.4" from the program list. 
  
 3. Select “TFG4000" to start.  
 
 4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”.  You can 

select “Close” to continue the start up process or select “Next Tip” to view more 
tips.  You can also choose not to have the “Tip of the Day” appear by selecting 
the check box next to “Don’t show Tip of the Day at Startup” located on the 
Welcome screen. Select the check box again at any time to reinstate the “Tip of 
the Day” feature. 

 
 5. If you see a “User” and “Password” field on your screen, enter the User ID and 

Password that your System Administrator provided you, and either press “Enter” 
or click “Sign On”.   

  
 6. If your screen only displays “Welcome” without any other fields, then click the 

plus sign (“+”) next to the application you want to perform in the “NavTree”.  
 
 7. Click on the screen you would like to use. 
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Multiple User (Not available in the Demo Version) 
 
 Server Startup 
 

At installation, the server component is put in the Startup folder of the Program List.  
It will automatically start at system start up.  Perform this procedure only if 
necessary. 

 
 1. Open the “Start” menu, and then select the “Program” option. 
 
 2. Select “TFG4000 V1.4” from the program list. 
  
 3. Select “TFG4000 Server V1.4" to start.   
 
 4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”.  You can 

select “Close” to continue the start up process or select “Next Tip” to view more 
tips.  You can also choose not to have the “Tip of the Day” appear by selecting 
the check box next to “Don’t show Tip of the Day at Startup” located on the 
Welcome screen. Select the check box again at any time to reinstate the “Tip of 
the Day” feature. 

 
 Client Startup 
 
 1. Open the “Start” menu, and then select the “Program” option. 
 
 2. Select “TFG4000 V1.4" from the program list. 
 
 3. Select “TFG4000 Client v1.4" to start.   
 
 4. The TFG4000 “Welcome” screen is displayed with the “Tip of the Day”.  You can 

select “Close” to continue the start up process or select “Next Tip” to view more 
tips.  You can also choose not to have the “Tip of the Day” appear by selecting 
the check box next to “Don’t show Tip of the Day at Startup” located on the 
Welcome screen. Select the check box again at any time to reinstate the “Tip of 
the Day” feature. 

 
 5. If you see a “User” and “Password” field on your screen, enter the User ID and 

Password that your System Administrator provided you, and either press “Enter” 
or click “Sign On”.  

 
 6. If your screen only displays “Welcome” without any other fields, click the plus ign 

(“+”) next to the application you want to perform in the “NavTree”.  
 
 7. Click on the screen you would like to use.
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Built-in Help 
 
Help is available at the screen, field, and column level, as well as built-in tool tips. 
 
Screen Level Help 
 
To select screen level help, click “Help” on the “Menu” bar, and then select “Screen Help”.  
Help for the screen is then displayed.  
 
 
 
 
 
 
Field Level Help 
 
To select field level help, right click on the field, and then click “Help” from the pop-up.  
Help for the selected field is then displayed.  You may also press the F1 key to get field 
help. 
 
 
 
 
 
 
 
Column Level Help 
 
To select column level help, right click on the column heading, and then click “Help” from 
the pop-up.  Help for the selected column is then displayed. 
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Tip of the Day 
 
Each time you start TFG4000, there is a “Tip of the Day” pop-up displayed that describes 
some of the functionality that is available within the application. To close the “Tip of the 
Day” pop-up, click the “Close” button. To view another tip, click the “Next Tip” button. This 
feature can be turned off by clicking the box next to “Don’t Show Tip of the Day at Startup” 
on the Welcome screen. A check mark will appear in the box indicating the “Tip of the Day” 
should not be displayed during start up. To reinstate the “Tip of the Day” feature, click the 
box and the check mark will disappear indicating the “Tip of the Day” should be displayed 
during start up. 
 
 Example Only: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Tool Tips 
 
Throughout TFG4000, there are embedded tool tips that help describe certain areas on the 
screen.  You simply roll your mouse (cursor) over the area in question, and a pop-up will 
describe that specific area. The tool tip pop-up will remain visible for a few seconds, then it 
will disappear automatically.  
 
 Example Only: 
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Using TFG4000 
 
You can navigate through the TFG4000 screens by using the “NavTree”, the “Goto Screen” 
section of the “View Menu”, and the tabs on the top and bottom of the screen.  For easy 
use, the toolbar provides a variety of functions for you to choose from as you use the 
TFG4000 applications.  There are buttons located on the toolbar that allow you to perform 
various functions from each screen, such as opening/displaying data, saving data, etc.  The 
“Menu” provides useful functions as well, such as printing reports, documentation, help, etc. 
 
 
Sample Screen 
 
 
 
 
 
  
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

   

   

 

Menus Toolbar Top Tabs Main 
Screen 

NavTree Bottom 
Tabs 

Message 
Line 



 

 11 

Menus 
 
Each screen in TFG4000 has various menus available for working with your data.  The 
following describes the purpose of each menu and special features. 
 
Action  
 
This menu is for printing screens and for exiting TFG4000.  It contains the following menu 
items: 
 
 Print    Prints the entire screen in either portrait or landscape 

mode. 
 
 Print Text    Prints only the text currently displayed on the screen in 

either portrait or landscape mode. 
 
 Exit     Terminates the TFG4000 session. 
 
Edit   
 
This menu is for performing cut, copy, and paste operations on data.  It contains the 
following menu items: 
 
 Cut     When you highlight data and use this function, the data 

is removed from the screen and is available in a 
clipboard for pasting.  Holding the “Ctrl” key and 
pressing the “X” key will perform the same operation. 

 
 Copy     When you highlight data and use this function, the data 

is copied into a clipboard and is available for pasting.  
Holding the “Ctrl” key and pressing the “C” key will 
perform the same operation. 

 
 Paste    When you position your cursor in a field and use this 

function, data you have previously put into the clipboard 
using the “Cut” or “Copy” operation will be pasted after 
your cursor.  Holding the “Ctrl” key and pressing the “V” 
key will perform the same operation. 

   
 Note:  If your keyboard is in “insert mode” the data will not overlay data that 

follows, but if it is not in “insert mode” it will.  Press the Insert key on your 
keyboard to change your insert mode to whichever way you prefer. 
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View   
 
This menu allows you to change the way the TFG4000 screens are presented and how you 
navigate the screens.  It contains the following menu items: 
 
 Set Font Size   You can choose a font size from 10 to 18.  With larger 

font sizes you may have to scroll to see the entire 
screen. 

  
 Hide Calendar Buttons  Toggles whether or not a Calendar button is displayed 

next to the date fields. 
 
 Flip Tree Position  Changes the position of the “NavTree” to either the left 

or the right side of the screen.  
 
 Hide Navigation Tree  Hides the “NavTree” from the screen.  Click it a second 

time to display the “NavTree” on the screen. 
 
      Note:  The dark arrows in the bar between the NavTree” 

and the main screen perform the same function. 
 
 GoTo Screen   Displays the “NavTree” in menu format.  You can use 

this method to navigate the screens at any time but it is 
particularly useful if you hide the “NavTree”. 

 
   
 
 
 
 
 
 
 
 
 
Reports    
 
This menu is only available if there are reports available for the screen you are on. There 
will be various menu items depending on the screen.   
 
Documentation  
 
This menu lets you select the TFG4000 manuals for viewing and printing.  
 
Help 
 
This menu provides help about the screen you are on and information about TFG4000.  It 
contains the following menu items: 
 
 Screen Help   Displays information about the screen you are on. 
 
 About    Displays information about TFG4000.
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Buttons & Icons 
 
Each screen in TFG4000 has various buttons available for working with your data.  The 
following describes the purpose of each button and special features.  It also explains other 
icons you may see on the screens. 
 
Toolbar Buttons  
 
Use the following buttons to perform TFG4000 application tasks. The buttons displayed 
change with the screen you are working with. 
 
Previous screens   
 
Use this button to return to your previous screen.  You can go back up to ten screens. 
 
Cutting, copying and pasting text  
 
You can use “Cut” and “Paste” to move selected text. You can use “Copy” and “Paste” to 
copy selected text and paste the copy in another place.  “Cut”, “Copy”, and “Paste” can also 
be selected from the “Edit” menu. 
 
Working with data     
 
You can erase, open, save, add, delete, get previous or next, copy, print, and refresh data 
by using these buttons: 
 
   Erase       This button clears data from the screen. It does not 

update any data; it merely clears the data away to make 
it easier for you to enter something else. It is 
particularly useful for resetting summary screens for a 
new search and it may be required when adding new 
entries on some screens. 

 
  Open (Display)  This button retrieves data that has been previously 

saved for viewing and/or modifying. The Enter key 
executes this button by default.  

 
   Save   This button stores new data and modified data. If you 

enter new data or change existing data and do not click 
this button, the system prompts you to do so. 

 

             Cancel   This button reduces any remaining quantities to zero 
and changes statuses to “Cancelled”. 

 

             Delete   This button deletes previously saved data. On screens 
indicated as “definition” screens, the delete button 
deletes related data in addition to the data currently 
displayed. On all other screens only the data displayed is 
deleted. 

 
         Previous   This button retrieves data that alphabetically precedes 

the currently displayed data. 
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       Next   This button retrieves data that alphabetically follows the 

currently displayed data.  
 
  Copy   This button copies data from one place to another.  On 

screens indicated as “definition” screens, it copies 
related data in addition to the data currently displayed.  
On all other screens, only the data displayed is copied. 

 
   Print   This button sends your document to the printer to be 

printed. 
 

  Build   This button extracts eligible data from one place to 
create a new definition in another place. For example, it 
can extract customer order data to build a new invoice. 

 
  Refresh   This button rebuilds the data on the screen. 
  
Screen Buttons 
 
Throughout the screens are buttons that perform functions.   
 
         Search   This button is for finding data you have already entered. 

When you click this button a search box pops up.  
 
        Calendar   This button provides a pop-up calendar for selecting 

dates.  You can choose the month and the year, and 
then double-click on the date you desire. Click “Today” 
to re-position the calendar on the current date.  Click 
“Cancel” if you decide not to select a date.  Dates can be 
entered without using the “Calendar” button if desired.  
Manually entered dates are verified so a pop-up appears 
prompting you to correct a date if it is invalid. 

 

  Dropdown   This button provides a “dropdown” list of pre-defined 
values from various fields that have this button next to 
it.  If you click on one of the values from the dropdown 
list, that value will appear in the adjacent field.  

    
Table Buttons 
 
 Throughout the tables are buttons that perform functions. 
 
      GoTo/Selection  This button is for either transferring to another screen or 

selecting data. When you right-click on this button, it 
displays a menu of related screens and/or a menu of 
selection activities.  To transfer to another screen, click 
on the screen you desire and that screen is displayed 
with the appropriate keys already filled in.  To select 
data, such as a component or inventory location, click 
the action you want.  
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  Properties   This button is located at the lower left corner of each 

table.  It allows you to edit the layout of the table. You 
can use this button to hide or display columns in the 
table and to restore the original table layout.  

    
  Add Rows   This button appears in the lower right corner of 

modifiable tables so that you can put more empty rows 
on the screen for adding data to the table.  If you are 
trying to enter another row in a table and there are not 
any blank rows to use, click the “Add Rows” button. 

 
  Scroll to the Left  This button allows you to scroll to the left of the table. 
 
  Scroll to the Right This button allows you to scroll to the right of the table. 
 
  Scroll Up   This button allows you to scroll up the table. 
 
  Scroll Down  This button allows you to scroll down the table. 
 
  Scroll Bottom  This button allows you to scroll to the very bottom of the 

table. 
  
  Scroll Top   This button allows you to scroll to the very top of the 

table. 
 
  Scroll Left   This button allows you to scroll to the very left of the 

table. 
 
  Scroll Right  This button allows you to scroll to the very right of the 

table. 
 
Information Icons 
 
Icons on the screen show properties about the field. 
 
       Numeric   This icon in the upper left corner of a field indicates that 

the field is for a numeric value.  You are able to enter 
only numbers, commas, and decimals in fields 
containing this icon. 

 
      Key   This icon to the left of a field indicates that the field is a 

key field and is required for this screen. 
 
         Required   If you try to display or save data without entering a 

required field, this checkmark icon is displayed next to 
the missing field. 
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Field Colors 
 
The fields on the screens and in screen tables have three different colors that have 
functional significance. 
 
 Gray  A gray field is display only, no entry allowed or necessary 
 
 White  A white field is open for entering data 
 
 Yellow A yellow field indicates where the cursor is currently positioned 
  
Changing Screen Table Properties 
 
Tables that appear on screens can be modified. The columns can be re-sized, re-positioned, 
hidden, and un-hidden.  
 
To re-size a column move your cursor over the column heading you want to re-size and 
move to the right until you see an arrow with two heads. Click, then still holding the mouse 
button down, move the cursor to the right until the column is as wide as you want or to the 
left until the column is as small as you want. 
 
To re-position a column click on the column heading, then still holding the mouse down, 
move the column to the where you want it and release the mouse.  Some columns are key 
columns and will not remain where you re-position them. 
 
Note: Re-sizing and re-positioning remain in effect for the duration of the current session. 
The default sizing and positioning is restored when TFG4000 is restarted. 
      
To hide or unhide a column click the Properties button  located in the lower left corner of 
the table. A red check mark next to the column name indicates the column will be 
displayed. If there is not red check mark next to the column name it will not be displayed in 
the table. There may be multiple tabs for the table, so you must click on the tab that 
contains the column(s) you want. To save the changes you have made, click the “OK” 
button. To discard the changes you have made, click the “Cancel” button. To reset the 
properties back to the default properties, click the “Restore Default Visibility” button. 
Another pop-up will appear asking the range you wish to restore. Use the dropdown 
provided to select either “All Tabs”, which will restore the defaults for the entire table, or 
“Currently Displayed Tab Only”, which will restore the default properties only for the portion 
of the table indicated by the tab you are viewing. Once you have made your selection click 
“OK” or “Cancel”. That pop-up will disappear and the column visibility properties are reset 
as requested or the reset action is cancelled. Then you may click either “OK” or “Cancel” to 
save or discard the property changes. 
 
Note: Property changes remain in effect even after TFG4000 is restarted. 
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Performing Searches 
 
There are two types of searches in TFG4000 that are similar in appearance, however they 
have different functionality.  The first is a “Search” associated with a field on the screen.   
The second is a “Search Pop-up” which is found on tables.  One of the differences between 
the two is that a “Search Pop-up” can load multiple table rows to the screen at one time but 
a “Search” will not. Another difference is that “Search” screen results can be printed but 
“Search Pop-up” results cannot. 
 
Search Screen (Fields) 
 
Below is an example of a search screen that may be used to locate information already 
entered into the system, and/or to automatically populate the fields on the screen that you 
are currently viewing or editing.  When search results are displayed you can move the 
columns into different places on the search screen so that the values can be viewed in 
positions different from the default layout. Click the heading of the column you wish to 
move then drag and drop it into the desired position. Resize columns by moving the cursor 
over the heading until you see an arrow with two heads. Click, and with the mouse button 
still down, move the cursor right or left until the column is the desired width. The default 
layout is restored when the “Search” button is pressed and when you exit the search. In 
addition, you also have the option to retain search parameters by checking the box located 
next to “Retain Search Parameters”.  This option allows you to save the search parameters 
you used for future searches.  
 
 Example Only: 
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Using the Search Screen 
  
 1. Click the Search button  located directly next to the field you want to search. 
 
 2. Enter the maximum number of rows of data you want to display in your results.  

The default is “30”. 
 
 3. Select one of the search choices using the dropdown.  The default is “starting 

with”. 
 
 
 
 4. Enter all or part of the value you want to search with.  You may leave the search 

field blank to return all applicable records in the database.  If there is a value in 
the screen field you are searching on, it will be copied to the search field.  You 
can change the search field value on the “Search” screen. 

 
 5. Click the Search button . 
 
 6. Double click on the row you desire to load the information to the main screen. 
 
Modifying the View of the Search Results 
 
To modify the view of the search results, do the following: 
 
 1. To re-size a column move your cursor over the column heading you want to re-

size and move to the right until you see an arrow with two heads. Click, then still 
holding the mouse button down, move the cursor to the right until the column is 
as wide as you want or to the left until the column is as small as you want. 

 
 2. To re-position a column click on the column heading, then still holding the mouse 

down, move the column to the where you want it and release the mouse.  Some 
columns are key columns and will not remain where you re-position them. 

 
 3. To re-size the window move your cursor over the edges of the window until you 

see an arrow with two heads. Click, and then still holding the mouse button 
down, move the cursor to increase or decrease the size of the window. 

 
Printing the Search Results 
 
To print the search results, use these steps: 
 
 1. Click the Print button  on the “Search” screen. 
 
 2. Type or select the appropriate formatting options in the dialog box and then click 

“OK” to print the report.   
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Search Pop-Up Screen (Tables) 
 
Below is an example of a search pop-up screen that may be used to populate columns in the 
table on the screen that you are currently viewing or editing.  When search results are 
displayed you can move the columns into different places on the search pop-up screen so 
that the values can be viewed in positions different from the default layout. Click the 
heading of the column you wish to move then drag and drop it into the desired position. 
Resize columns by moving the cursor over the heading until you see an arrow with two 
heads. Click, and with the mouse button still down, move the cursor right or left until the 
column is the desired width. The default layout is restored when the “Do Search” button is 
pressed and when you exit the search pop-up.   
 
 Example Only: 
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Using the Search Pop-Up Screen 
 
 1. Right Click the GoTo/Selection button  in the row you want to search. 
 
 2. Enter the maximum number of rows of data you want to display in your results.  

The default is “30”. 
  
 3. Select one of the search choices using the dropdown.  The default is “starting 

with”. 
 
 4. Enter all or part of the value you want to search with.  You may leave the search 

field blank to return all applicable records in the database.  
 
 5. Click the “Do Search” button. 
 
 6. To select just one entry, double-click on it to populate the fields on your screen.   
 
 7. To select more than one entry, hold down the “Control” key while you click on the 

other selections with your mouse, then click “Load to Screen” to populate the 
information.   

 
 8. To load all of the entries to the screen table, click the “Select All” button and then 

click the “Load to Screen” button. 
 
Modifying the View of the Search Results 
 
To modify the view of the search results, do the following: 
 
 1. To re-size a column move your cursor over the column heading you want to re-

size and move to the right until you see an arrow with two heads. Click, then still 
holding the mouse button down, move the cursor to the right until the column is 
as wide as you want or to the left until the column is as small as you want. 

 
 2. To re-position a column click on the column heading, then still holding the mouse 

down, move the column to the where you want it and release the mouse.  Some 
columns are key columns and will not remain where you re-position them. 

 
 3. To re-size the window move your cursor over the edges of the window until you 

see an arrow with two heads. Click, and then still holding the mouse button 
down, move the cursor to increase or decrease the size of the window. 

 
Printing the Search Results 
 
To print the search results, use these steps: 
 
 1. Click the Print button  on the “Search” screen. 
 
 2. Type or select the appropriate formatting options in the dialog box and then click 

“OK” to print the report.   
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Working with Reports 
 
You can view, modify, and print reports by using the “Reports” menu located just above the 
toolbar.  If “Reports” is faded gray, then there are no reports available for that screen.   
 
 To view a report, follow these steps: 
 
 1. Click on “Reports” above the toolbar.  A menu will drop down indicating which 

reports can be generated from that screen.  Click on the report name that you 
want.   

 
 2. A status window will appear showing that the system is generating the report. 
 
 3. You will then see your report displayed on the screen. 
 
 To modify and/or print a report, follow these steps: 
 
 1. Click on “Reports” above the toolbar.  A menu will drop down indicating which 

reports can be generated from that screen.  Click on the report name that you 
want.   

 
 2. A status window will appear showing that the system is generating the report. 
 
 3.  You will then see your report displayed on the screen with this toolbar at the     

top: 
 
 
 
    
 
 Printing Options   Allows you to set the Page Number Prefix, number of 

pages wide, and the Repeat Section Header/Footer 
settings.  Adjust the settings to your specifications and 
then click “OK”. 

 
 Page Setup    Allows you to adjust page settings.  Once finished 

adjusting the settings, click “OK”. 
 
 Print     Allows you to select printer settings and print your 

report.  Once finished with settings, click “OK” to print 
the report. 

 
 Preview    Allows you to preview your report layout before you 

actually print.  Once finished previewing, click “Close”. 
 
 Excel     Allows you to save your report as an Excel document.  

Once finished naming and specifying where to save your 
report, click “Save”. 

 
 Revert    Allows you to discard all layout changes and revert to 

default settings.  Simply click either “Yes”, or “No”. 
 
 Help    Shows the Report Layout Instruction screen.
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In some reports the selection criteria can be changed in the report window. Adjust the 
selection criteria as desired, and then click the “Refresh” button to reload the data. When 
you exit the report you will be asked if you want to update the screen with the refreshed 
data from the report. Click “Yes” to update the screen or “No” to leave the screen as it was 
when you started the report. 
 
Report layouts can be modified. The columns can be re-sized, hidden, and un-hidden.  
 
To re-size a column move your cursor over the column heading you want to re-size and 
move to the right until you see an arrow with two heads. Click, then still holding the mouse 
button down, move the cursor to the right until the column is as wide as you want or to the 
left until the column is as small as you want. 
 
To hide or unhide a column right click in the report area, then select the “Column Visibility” 
tab. A red check mark next to the column name indicates the column will be displayed. If 
there is not red check mark next to the column name it will not be displayed in the report. 
To save the changes you have made, click the “OK” button. To discard the changes you 
have made, click the “Cancel” button. To reset the properties back to the default properties, 
click the “Revert” button located on the report toolbar. A dialog box will appear asking if you 
want to discard changes and revert back to default settings. Click either “Yes” to restore the 
defaults or “No” to keep the changes. 
 
Note: Report layout changes remain in effect even after TFG4000 is restarted.
Working with Summary Screens and Summary Reports 
 
TFG4000 has many summary screens and reports available for locating data, listing data, 
and summarizing data. Each summary screen and report has various fields for search 
criteria that are used in combination with one another. The search criteria fields can use 
wildcards and other sophisticated SQL search techniques. For more information about 
wildcard characters that can be used for advanced searching, refer to the following Microsoft 
website: 
 
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/off2000/html/acconWildcardCharactersS.asp 
 
Due to differences between Access and ANSI wildcard characters, when reading this website 
and using wildcards in TFG4000, substitute as follows: 
 
% for *  
_ for ?   
# is not used 
 
Also note that these wildcards cannot be used in searches. 
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Calendar 
 
What is the Calendar for? 
 
The calendar screen is used to indicate which dates are non-working days so scheduling 
processes won’t select a non-working date. 
 
Calendar Screens 
 
There is only one calendar screen. 
 
Calendar 
 
This screen allows you to indicate which dates are non-working days. There is a dropdown 
provided so you can show what type of non-working day it is: Weekend, Holiday, Vacation, 
Off Day.   
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Calendar Screen Explained 
 
Calendar Screen 
 
This screen allows you to indicate which dates are non-working days. 
 
Calendar Table 
 
Column     Explanation 
 
Date      A date selected to be a non-working day. 
 
Day      The day of the week of the non-working day. 
 
Type      Type of non-working day: 
       
      Weekend 
      Holiday 
      Vacation 
      Off Day 
 
Delete      This is a checkbox to indicate you want to delete a 

calendar entry.  
 
Message Line 
 
Field      Explanation 
 
Message     Displays information about the current status of the 

screen. 
 
 
Accessing the Calendar Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Calendar”.  The Calendar screen is displayed. 
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Using the Calendar Screen 
 
Use these procedures to erase the screen, display, and delete calendar entries. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Displaying the Calendar 
 
To display the calendar, perform the following steps: 
 
 1. Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 2. The calendar is displayed on the main screen. 
 
Deleting a Calendar Entry 
 
To delete an entry from the calendar, perform the following steps: 
  

1. Display the calendar.  See “Displaying the Calendar” above. 
 
 2. Click the checkbox  in the “Delete” column of the Calendar table for the row 

you want to delete.  You may select more then one row to be deleted at one 
time.  Click the checkbox  again to remove the deletion flag. 

 
 3. Once finished, click the Save button  located on the toolbar. 
 
 Note: Once a calendar entry is deleted, it can no longer be displayed or updated. 
 
Calendar Reports 
 
The Calendar screen has the following report available: 
 
 Calendar Report 
 Basically the same information displayed on the Calendar screen. 
 
For more information about viewing, modifying, and printing reports, see “Working with 
Reports” in the “Using TFG4000” section of this manual. 
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Employee 
 
What is an Employee? 
 
An employee is any person employed by your company for whom information must be 
stored. 
 
Employee Screens 
 
“Employee” consists of five tabbed screens that are used to enter and maintain employee 
data.  Each screen is used for specific purposes to aid in the entry and maintenance of 
employee information. 
 
Employee 
 
The employee screen allows you to define an employee with basic information about the 
employee such as the type of employee, status, address, etc. 
 
Contact 
 
The employee contact screen allows you to enter an employee contact and if necessary, 
multiple contacts for an employee who has more than one contact. You can enter as many 
contacts as you need for an employee. 
 
Information 
 
This screen allows you to enter text you wish to maintain concerning an employee.  For 
example, you could enter text information for an employee that describes specific details 
about performance for this employee. You can also attach references to external 
documents, including electronic documents such as spreadsheets, drawings and word 
processor documents, references to physical documents such as books and maps, and 
references to URL’s for web sites.  
 
Skills 
 
This screen allows you to define the skills this employee possesses and the pay rate used 
when the employee is assigned a task requiring a particular skill. 
 
Schedule 
 
This screen allows you to designate how many shifts per day of the week and how many 
hours for each shift an employee may work. 
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Employee Screens Explained 
 
Employee Screen 
 
This screen is for defining an employee with basic information about the employee. 
 
Current Employee 
 
Field      Explanation 
 
Employee     A unique identifier assigned to each employee.  It is the 

main key for all other employee data. 
 
Type      The classification of the employee.  A dropdown list of 

values is provided for your convenience.  You can use 
those values or define your own using the "Dropdown 
Control" screen under "System Administration".  Some 
examples of types are: "Full Time”, “Part Time” or 
“Contractor”.  

 
Name      The full name of the employee defined here. 
 
Status      Specifies whether the employee is “Active” or “Inactive”. 
 
Title      The employee’s title within this organization. 
 
SSN      The employee’s social security number. 
 
Employee Data 
 
Field      Explanation 
 
Line 1      First line of the address for this employee. 
 
Line 2      Second line of the address for this employee. 
 
Line 3      Third line of the address for this employee. 
 
City       City for this address.  
 
State      State associated with this address. 
 
Zip      Postal Zip Code for this address. 
 
Country     Country associated with this address. 
 
Phone      Telephone number, including area code, for this 

employee. 
 
Extension     Extension number for the employee. 
 
Fax      Fax telephone number, including area code, for this 

employee. 
 



 

 28 

URL Address    URL (Universal Resource Locator) or Website address for 
this carrier. 

 
E-Mail      E-Mail address for this employee. 
 
Hire Date     Date this employee was hired. 
 
Term Date     Date the employee terminated employment. 
 
Work Center    Work Center where this employee is assigned. 
 
Default Rate    The basic pay rate for the employee. 
 
Rate Unit     Unit of measure for the Default Rate (Hours). 
 
Overtime Rate   Pay rate for the employee when working overtime. 
 
Rate Unit     Unit of measure for the Overtime Rate (Hours) 
 
Rate Factor    Multiplication factor applied to the Default Rate to 

determine the Overtime Rate (can be used instead of a 
specific Overtime Rate) 

 
Holiday Rate    Pay rate for the employee when working on a holiday. 
 
Rate Unit     Unit of measure for the Holiday Rate (Hours) 
 
Rate Factor    Multiplication factor applied to the Default Rate to 

determine the Holiday Rate (can be used instead of a 
specific Holiday Rate) 

 
Message Line 
 
Field      Explanation 
 
Message     Displays information about the current status of the 

screen including error messages. 
 
 
Accessing the Employee Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Employee”.  The Employee screen is displayed. 
 
 3. If there is an employee number in the “Employee” field, the data for that 

employee is displayed on the main screen. 
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Using the Employee Screen 
 
Use these procedures to erase the screen, display, add, update, delete, display the 
previous, and display the next employee. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Displaying an Existing Employee 
 
To display an employee, perform the following steps: 
 
 1. Enter an employee number in the “Employee” field. 
 
 2. Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 3. The employee data is displayed on the main screen. 
 
  -or- 
 
 1. Use the Search button  next to the “Employee” field or the “Name” field, or the 

second Search button   next to the “Work Center” field to select an employee 
number. 

 
 2. Double-click on the “Employee” you would like to display in the “Search” screen 

table. 
 
 3. The employee data is displayed on the main screen. 
 
Adding a New Employee 
 
To add an employee, perform the following steps: 
 
 1. Click the Erase button  located on the toolbar to clear the screen. 
 
 2. Enter an employee number in the “Employee Number” field. It can be any 

combination of numbers and letters. 
 

3. Enter data in any of the other fields you desire, these fields are optional. 
 
 4. When done, click the Save button  located on the toolbar. 
 
  -or- 
 
 1. Display an existing employee.  See “Displaying an Existing Employee” above. 
 
 2. Enter a new employee number in the “Employee Number” field and change any of 

the fields you desire.  
 
 3. When done, click the Save button  located on the toolbar. 
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 Tip: The second procedure above can be used to copy employee data to a new 

employee number; however, contacts, text, skills, and schedules are not 
copied with this procedure. 

 
Updating an Existing Employee 
 
To update an existing employee, perform the following steps: 
 
 1. Display the employee data you wish to change.  See “Displaying an Existing 

Employee” above. 
 

2. Change the desired information on the screen. 
 
 3. When done, click the Save button  located on the toolbar.  
 
Deleting an Existing Employee 
 
To delete an existing employee, perform the following steps: 
  
 1. Display the employee data you wish to delete.  See “Displaying an Existing 

Employee” above. 
 

 2. Click the Delete button  located on the toolbar.   
 
 3. Click the “Yes” button on the “Confirm Action” pop up message.  If you do not 

want to delete the employee click “No” on the “Confirm Action” pop up message. 
 
 Note: Once an employee is deleted, it can no longer be displayed or updated. 
 
Displaying the Previous Employee 
 
To display the employee that precedes the one currently displayed, perform the following 
steps: 
 
 1. Click the Previous button  located on the toolbar. 
  
 2. The previous employee data is displayed on the main screen. 
 
Displaying the Next Employee 
 
To display the employee that follows the one currently displayed, perform the following 
steps: 
 
 1. Click the Next button  located on the toolbar. 
 
 2. The next employee data is displayed on the main screen. 
 
 Tip: You can use the Next button as a convenient way to locate the first record in 

the database.  Start by erasing the screen using the Erase button  or 
blanking out the “Employee” field, then click the Next button . 
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Contact Screen 
 
This screen is for entering and maintaining contacts for an employee. Multiple contacts can 
be defined and maintained. 
 
Current Employee 
 
Field      Explanation 
 
Employee     A unique identifier assigned to each employee.  It is the 

main key for all other employee data.  
 
Type      The classification of the employee. Some examples of 

types are: "Full Time”, “Part Time” or “Contractor”.  
 
Name      The full name of the employee. 
 
Status      Specifies whether the employee is “Active” or “Inactive”. 
 
Title      The employee’s title within this organization. 
 
SSN      The employee’s social security number. 
 
Contact Data 
 
Field      Explanation 
 
Contact Name    Name of the contact. 
 
Sequence     Number used internally to keep track of contacts. 
 
New Contact    Indicates if you are adding this person as a new contact. 
 
Line 1      First line of the address for this contact. 
 
Line 2      Second line of the address for this contact. 
 
City       City for this address.  
 
State      State associated with this address. 
 
Zip      Postal Zip Code for this address. 
 
Country     Country associated with this address. 
 
Relationship    How this contact is related to the employee. 
 
Phone      Telephone number, including area code, for this contact. 
 
Extension     Telephone extension. 
 
Fax      Fax telephone number, including area code, for this 

contact. 
 
E-Mail      E-Mail address for this contact. 
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URL Address    URL (Universal Resource Locator) or Website address for 

this contact. 
 
Message Line 
 
Field      Explanation 
 
Message     Displays information about the current status of the 

screen including error messages. 
 
 
Accessing the Contact Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Employee”.  The Employee screen is displayed. 
 
 3. If there is an employee number in the “Employee” field, the information for that 

employee is displayed on the main screen. 
 
 4. Click the “Contact” tab at the top of the main screen. 
 
 5. If there is an employee number in the “Employee” field, the first contact found 

for that employee is displayed on the main screen. 
 



 

 33 

Using the Contact Screen 
 
Use these procedures to display, add, update, delete, display the previous, and display the 
next employee contact. 
 
Displaying an Existing Contact 
 
To display employee contact information, perform the following steps: 
 
 1. Enter an employee number in the “Employee” field. 
 
 2. Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 3. The first contact found for the employee is displayed on the main screen. 
 
 4. Click the Next button  to view the next contact for this employee or the first 

contact for the next employee. 
 
  -or- 
 
 1. Use the Search button  next to the “Employee” field, or the “Name” field to 

select an employee number. 
 
 2. Double-click on the employee you would like to display in the “Search” screen 

table. 
 
 3. The first contact found for the employee is displayed on the main screen. 
 
 4. Click the Next button  to view the next contact for this employee or the first 

contact for the next employee. 
 
Adding an employee Contact 
 
To enter an employee contact, perform the following steps: 
            
 1. Enter or select the employee number you want. 
 
 2. Enter contact data in the fields provided. 
 
 3. Click the checkbox next to “New Contact” to indicate you are adding this person 

as a new contact. 
 
 4. Once finished, click the Save button  located on the toolbar. 
 
 Updating Existing Contact Information  
 
To update existing contact information, perform the following steps: 
  
 1. Display the employee address data you want to change.  See “Displaying an 

Existing Contact” above. 
  
 2. Change the contact data as necessary. 
 
 3. Once finished, click the Save button  located on the toolbar. 
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Deleting Existing Contact Information 
 
To delete existing contact information, perform the following steps: 
  
 1. Display the employee contact you want to delete.  See “Displaying an Existing 

Contact” above. 
 

 2. Click the Delete button  located on the toolbar.   
 
 3. Click the “Yes” button on the “Confirm Action” pop up message.  If you do not 

want to delete the contact click “No” on the “Confirm Action” pop up message. 
 
 4. The contact is deleted. 
 
 Note: Once contact information is deleted, it can no longer be displayed or updated. 
 
Displaying the Previous Existing Contact 
 
To display the contact data that precedes the one currently displayed, perform the following 
steps: 
 
 1. Click the Previous button  located on the toolbar. 
 
 2. The previous contact is displayed on the main screen. 
 
Displaying the Next Existing Contact 
 
To display the contact data that follows the one currently displayed, perform the following 
steps: 
 
 1. Click the Next button  located on the toolbar. 
 
 2. The next contact is displayed on the main screen. 
 
 Tip: You can use the Next button as a convenient way to locate the first record in 

the database.  Start by erasing the screen using the Erase button  or 
blanking out the “Employee” field, then click the Next button . 
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Information Screen 
 
This screen allows you to enter text you wish to maintain concerning an employee.  For 
example, you could enter text information for an employee about performance.  You can 
also attach references to external documents, including electronic documents such as 
spreadsheets, drawings and word processor documents, references to physical documents 
such as books and maps, and references to URL’s for web sites.  
 
Current Employee 
 
Field      Explanation 
 
Employee     A unique identifier assigned to each employee.  It is the 

main key for all other employee data.  
 
Name      The full name of the employee. 
 
Type      The classification of the employee. Some examples of 

types are: "Full Time”, “Part Time” or “Contractor”.  
 
Information Table  
 
Column     Explanation 
 
Row      The line number of the row in the table. 
 
Info Type      A designation for the type of information stored.  A 

dropdown list of values is provided for your convenience. 
You can use those values or define your own using the 
"Dropdown Control" screen under "System 
Administration".   

 
Text Information   This is where you enter text information or view text 

that has already been entered. 
 
Delete      This is a checkbox to indicate you want to delete a text 

record. 
 
Reference Table 
 
Column     Explanation 
 
Row      The line number of the row in the table. 
 
Reference Type   A designation for the type of reference stored.  A 

dropdown list of values is provided for your convenience. 
You can use those values or define your own using the 
"Dropdown Control" screen under "System 
Administration".   
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Reference     Directory and file name for an electronic reference, URL 
for a website, or description of where to find a physical 
reference.  An electronic reference can be a 
spreadsheet, a word processor document, or a text file.  
A physical reference can be the name of a book with the 
page number.  

 
Delete      This is a checkbox to indicate you want to delete a 

reference record. 
 
Message Line 
 
Field      Explanation   
 
Message     Displays information about the current status of the 

screen including error messages. 
 
 
Accessing the Information Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click   “Common 

Applications” in the “NavTree”.   
 
      -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2.  Click “Employee”.  The Employee screen is displayed. 
 

3. If there is an employee number in the “Employee” field, the information for that 
employee is displayed on the main screen. 

 
 4.  Click the “Information” tab at the top of the main screen. 
 

5. If there is an employee number in the “Employee” field, the information text 
types and reference information for that employee are displayed on the main 
screen. 
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Using the Information Screen  
 
Use these procedures to display, add, update, delete, display the previous, and display the 
next employee information or references. 
 
Displaying Existing Information and References 
 
To display information or references, perform the following steps: 
 
 1.  Enter an employee number in the “Employee” field and click the Open (Display) 

button  located on the toolbar or hit the Enter key. 
 
       -or- 
 
  Use the Search button  next to the “Employee” field, or the “Description” field 

to select an employee number and double-click on the “Employee” you would like 
to display in the “Search” screen table. 

 
 2. The information text types and references for the employee are displayed on the 

main screen. 
 

  3.  To display information text, click the Goto/Selection button  in the “Text 
Information” column of the Text table for the row you want to display and select 
“Edit Information Text” on the menu that appears.  Use the scroll bar on the right 
to display more rows if necessary. 

 
 4.  The text will be displayed in a pop-up window. 
 

5. The reference information is displayed in the Reference table.  Use the scroll bar 
on the right to display more rows if necessary. 

 
 6. To view electronic references, right click on the reference you would like to 

display.  Choose “Goto External Application” from the menu. 
 
Adding Information 
 
To enter information, perform the following steps: 
 

1. Display the employee you want.  See “Displaying Existing Information and 
References” above. 

 
 2. Click an empty row in the Information table.  If there are no empty rows click the 

Add Rows button  in the lower right corner of the table. 
 
 3. Type the first letter of the text type you want (type the letter multiple times if 

there is more than one type that begins with the same letter). 
 
  -or- 
 

Using the dropdown list, select the Information Text Type in the “Info Type” 
column of the Information table.   
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  4.  Click the Goto/Selection button  in the “Text Information” column of the Text 
table for the row you want and select “Edit Information Text” on the menu that 
appears.  Use the scroll bar on the right to display more rows if necessary. 

 
 5.  The text will be displayed in a pop-up window. 

 
 6.   Enter the desired information in the pop-up window and click “Ok” when done. 
 
 7. Once finished, click the Save button  located on the toolbar. 
 
 Note: You can add employee information and references at the same time.  
 
Adding References 
 
To enter references, perform the following steps: 
            
 1. Display the employee you want.  See “Displaying Existing Information and 

References” above. 
 
 2. Click an empty row in the Reference table.  If there are no empty rows click the 

Add Rows button  in the lower right corner of the table. 
 
 3. Type the first letter of the reference type you want (type the letter multiple times 

if there is more than one type that begins with the same letter). 
 
        -or- 
 

Using the dropdown list, select the Reference Type in the “Reference Type” 
column of the Reference table.   

 
 4. Enter the reference in the “Reference” column. 
 
        -or-  
 

For an electronic reference, right click the reference you want to update.  Choose 
“Select External File”. A standard Windows file selection dialog is displayed. 
Locate the directory that contains the file you want. Select the file you want and 
click the “Open” button. 

 
 5. Once finished, click the Save button  located on the toolbar. 
 
 Note: You can add employee information and references at the same time.  
 
Updating Existing Information 
 
To update existing information, perform the following steps: 

 
1. Display the employee data you want to change.  See “Displaying Existing 

Information and References” above. 
 

  2.  Click the Goto/Selection button  in the “Text Information” column of the Text 
table for the row you want to update and select “Edit Information Text” on the 
menu that appears.  Use the scroll bar on the right to display more rows if 
necessary. 
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 3.  The text will be displayed in a pop-up window. 
 

 4.   Change the desired information in the pop-up window and click “Ok” when done. 
 
 5. Once finished, click the Save button  located on the toolbar. 
 
 Note: You can update employee information and references at the same time. 
 
Updating Existing References 
 
To update existing references, perform the following steps: 
 
 1. Display the employee data you want to change.  See “Displaying Existing 

Information and References” above. 
 
 2. Enter the new reference in the “Reference” column of the Reference table for the 

row or rows you wish to update. 
 
        -or- 
 

For an electronic reference, right click the reference you want to update.  Choose 
“Select External File”. A standard Windows file selection dialog is displayed. 
Locate the directory that contains the file you want. Select the file you want and 
click the “Open” button. 

 
 3. Once finished, click the Save button  located on the toolbar. 
 
 Note: You can update employee information and references at the same time. 
 
Deleting Existing Information and References  
 
To delete existing information and references, perform the following steps: 
 
 1. Display the employee data that has the information text and/or reference you 

want to delete.  See “Displaying Existing Information and References” above. 
 
 2. To delete text information, click the checkbox  in the “Delete” column of the 

Information table for the row you want to delete.  You may select more then one 
row to be deleted at one time.  Click the checkbox  again to remove the 
deletion flag. 

 
 3. To delete reference information, click the checkbox  in the “Delete” column of 

the Reference table for the row you want to delete.  You may select more then 
one row to be deleted at one time.  Click the checkbox  again to remove the 
deletion flag. 

 
 4. Once finished, click the Save button  located on the toolbar. 
 
 Note: Once employee information and references are deleted, they can no longer be 

displayed or updated. Deleting a reference to an external file does not delete 
the actual file; it deletes only the reference to the file. 
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Displaying the Previous Existing Information and References 
 
To display the information and references for the employee that precedes the employee 
currently displayed, perform the following steps: 
 
 1. Click the Previous button  located on the toolbar. 
 
 2. The information and references for the previous employee are displayed on the 

main screen. 
 
Displaying the Next Existing Information and References 
 
To display the information and references for the employee that follows the employee 
currently displayed, perform the following steps: 
 
 1.  Click the Next button  located on the toolbar. 
 
 2.  The information and references for the next employee are displayed on the main 

screen. 
 

Tip: You can use the Next button as a convenient way to locate the first record in 
the database.  Start by erasing the screen using the Erase button  or 
blanking out the “Employee” field, then click the Next button . 
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Skills Screen 
 
This screen allows you to define the skills this employee possesses and the pay rate to be 
used when the employee is assigned a task requiring a particular skill. 
 
Current Employee 
 
Field      Explanation 
 
Employee     A unique identifier assigned to each employee.  It is the 

main key for all other employee data.  
 
Type      The classification of the employee. Some examples of 

types are: "Full Time”, “Part Time” or “Contractor”.  
 
Name      The full name of the employee. 
 
Status      Specifies whether the employee is “Active” or “Inactive”. 
 
Title      The employee’s title within this organization. 
 
SSN      The employee’s social security number. 
 
Skills Table  
 
Column     Explanation 
 
Row      The line number of the row in the table. 
       
Skill      Work ability or expertise this employee possesses. 
 
Description    Short description of the skill.  
 
Rate      Pay rate for this particular employee skill. 
 
Skill Time Unit   The measure of time used for the skill (Hours). 
 
Delete      This is a checkbox to indicate you want to delete a skill 

from the employee’s skill list. 
 
Message Line 
 
Field      Explanation 
 
Message     Displays information about the current status of the 

screen. 
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Accessing the Skills Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
      -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2.  Click “Employee”.  The Employee screen is displayed. 
 

3. If there is an employee number in the “Employee” field, the information for that 
employee is displayed on the main screen. 

 
 4.  Click the “Skills” tab at the top of the main screen. 
 

5. If there is an employee number in the “Employee” field, the skills list for that 
employee is displayed on the main screen. 
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Using the Skills Screen 
 
Use the following procedures to erase the screen, display, update, add, delete, display the 
previous, or display the next employee skills list. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Displaying an Existing Skills List 
 
To display an employee’s skills list, perform the following steps: 
 
 1.  Enter an employee number in the “Employee” field. 
 
 2.  Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 3.  The skills list for the employee is displayed on the main screen. 
 
       -or- 
 
 1. Use the Search button  next to the “Employee” field, or the “Description” field 

to select an employee number. 
 

2. Double-click on the “Employee” you would like to display in the “Search” screen 
table. 

 
 3.  The skills list for the employee is displayed on the main screen. 
 
Updating and Adding Skills Data for an Employee 
 
To edit existing skills data or add new skills data for an employee: 
 

1. Display the employee you wish to change.  See “Displaying an Existing Skills List” 
above. 

 
 2. Change the skills data as needed.  You can use the Add Rows button  located 

on the toolbar to add additional rows for entry.  
 
 3. When all of the appropriate columns are changed, click the Save button  

located on the toolbar. 
 
Deleting Skills from an Employee 
 
Perform the following steps to delete skills from an employee: 
 

1. Display the employee you wish to change.  See “Displaying an Existing Skills List” 
above. 

 2. Click the “Delete” checkbox  next to the row(s) you want to delete. You may 
select more then one row to be deleted at one time.  Click the checkbox  again 
to remove the deletion flag. 
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 3. When all of the appropriate rows are selected, click the Save button  located on 

the toolbar.  
 
Displaying the Previous Skills List 
 
To display the skills list that precedes the skills list currently displayed, perform the 
following steps: 
 
 1. Click the Previous button located on the toolbar. 
 
 2. The previous skills list is displayed on the main screen. 
 
Displaying the Next Skills List 
 
To display the skills list that follows the skills list currently displayed, perform the following 
steps: 
 
 1. Click the Next button located on the toolbar. 
 
 2. The next skills list and its operations are displayed on the main screen. 
 
 Tip: You can use the Next button as a convenient way to locate the first record 

in the database.  Start by erasing the screen using the Erase button  , then 
click the Next button . 
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Schedule Screen 
 
This screen allows you to designate how many shifts per day of the week and how many 
hours for each shift an employee may work. 
 
Current Employee 
 
Field      Explanation 
 
Employee     A unique identifier assigned to each employee.  It is the 

main key for all other employee data. 
 
Type      The classification of the employee. Some examples of 

types are: "Full Time”, “Part Time” or “Contractor”.  
 
Name      The full name of the employee. 
 
Status      Specifies whether the employee is “Active” or “Inactive”. 
 
Title      The employee’s title within this organization. 
 
SSN      The employee’s social security number. 
 
Shift Schedules 
 
Field      Explanation 
 
Monday Shifts    The number of shifts this employee works on Mondays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Mondays. 
 
Tuesday Shifts   The number of shifts this employee works on Tuesdays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Tuesdays. 
 
Wednesday Shifts   The number of shifts this employee works on 

Wednesdays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Wednesdays. 
 
Thursday Shifts   The number of shifts this employee works on Thursdays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Thursdays. 
 
Friday Shifts    The number of shifts this employee works on Fridays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Fridays. 
 
Saturday Shifts   The number of shifts this employee works on Saturdays. 
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Hours Per Shift   The number of hours per shift this employee works on 
Saturdays. 

 
Sunday Shifts    The number of shifts this employee works on Sundays. 
 
Hours Per Shift   The number of hours per shift this employee works on 

Sundays. 
 
Total Shifts    The total number of shifts this employee works in a 

week. 
 
Total Hours    The total number of hours this employee works in a 

week. 
 
Message Line 
 
Field      Explanation 
 
Message     Displays information about the current status of the 

screen including error messages. 
 
 
Accessing the Employee Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Employee”.  The Employee screen is displayed. 
 
 3. If there is an employee number in the “Employee” field, the data for that 

employee is displayed on the main screen. 
 
 4.  Click the “Schedule” tab at the top of the main screen. 
 

5. If there is an employee number in the “Employee” field, the schedule for that 
employee is displayed on the main screen. 
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Using the Schedule Screen 
 
Use these procedures to erase the screen, display, add, update, delete, display the 
previous, and display the next employee schedule. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Displaying an Existing Employee Schedule 
 
To display an employee schedule, perform the following steps: 
 
 1. Enter an employee number in the “Employee” field. 
 
 2. Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 3. The employee schedule data is displayed on the main screen. 
 
  -or- 
 
 1. Use the Search button  next to the “Employee” field, the “Name” field, the 

“Employee Code” field, the “Type” field, or the “Status” field to select an 
employee number. 

 
 2. Double-click on the “Employee” you would like to display in the “Search” screen 

table. 
 
 3. The employee schedule data is displayed on the main screen. 
 
Adding a New Employee Schedule 
 
To add an employee schedule, perform the following steps: 
 

1. Display the employee you wish to change.  See “Displaying an Existing Employee 
Schedule” above. 

 
2. Enter data in any of the other fields you desire. 

 
 3 When done, click the Save button  located on the toolbar. 
 
  -or- 
 
 1. Display an existing employee schedule see “Displaying an Existing Employee 

Schedule” above. 
 
 2. Enter another employee number in the “Employee Number” field and change any 

of the fields you desire.  
 
 3. When done, click the Save button  located on the toolbar. 
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 Tip: The second procedure above can be used to copy employee schedule data to 

another employee. 
 
Updating an Existing Employee Schedule 
 
To update an existing employee schedule, perform the following steps: 
 
 1. Display the employee schedule data you wish to change.  See “Displaying an 

Existing Employee Schedule” above. 
 

2. Change the desired information on the screen. 
 
 3. When done, click the Save button  located on the toolbar.  
 
Deleting an Existing Employee Schedule 
 
To delete an existing employee schedule, perform the following steps: 
  
 1. Display the employee schedule you wish to delete.  See “Displaying an Existing 

Employee Schedule” above. 
 

 2. Click the Delete button  located on the toolbar.   
 
 3. Click the “Yes” button on the “Confirm Action” pop up message.  If you do not 

want to delete the employee click “No” on the “Confirm Action” pop up message. 
 
 Note: Once an employee schedule is deleted, it can no longer be displayed or 

updated. 
 
Displaying the Previous Employee Schedule 
 
To display the employee schedule that precedes the one currently displayed, perform the 
following steps: 
 
 1. Click the Previous button  located on the toolbar. 
  
 2. The previous employee schedule is displayed on the main screen. 
 
Displaying the Next Employee 
 
To display the employee schedule that follows the one currently displayed, perform the 
following steps: 
 
 1. Click the Next button  located on the toolbar. 
 
 2. The next employee schedule is displayed on the main screen. 
 
 Tip: You can use the Next button as a convenient way to locate the first record in 

the database.  Start by erasing the screen using the Erase button  or 
blanking out the “Employee” field, then click the Next button . 
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Location Control 
 
What is a Location? 
 
A location is a place where inventory is stored. It can be a physical location such as a 
stockroom or row/bin/aisle designation or it can be a logical location such as Stock1-
Vendor1, Stock1-Vendor2, where the physical location is logically separated. 
 
Location Screens 
 
Location Control consists of three tabbed screens that are used to enter and maintain 
location data.   
 
Location Definition 
 
The location definition screen allows you to define a location with basic information about 
the location such as the type of location, status, etc. 
 
Location Summary 
 
The location summary screen allows you to list locations based on selection criteria entered. 
 
Location Generation 
 
The location generation screen allows you to specify various parameters then generate 
multiple location definitions based on those parameters. 
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Location Definition Screen 
 
The location definition screen allows you to enter and display inventory location definitions. 
 
Current Location 
 
Field     Explanation 
 
Location    Field for entering all or part of a location name to select the 

locations to be displayed in the Location table. Leave this field 
blank to select all locations. 

Type      Information indicating the type of “Location”. A 
dropdown list of values is provided for your convenience. 
You can use those values or define your own using the 
"Dropdown Control" screen.  Some examples of Location 
Types include: WIP Stores, Inventory, Finished, 
Warehouse and Tool Crib. 

Description   Brief description of the location. 

Status     Information indicating the status of the Location: 
“Active”, “Inactive”, “Hold”, or “Quarantine”. 

Location Data 
 
Field     Explanation 
 

Warehouse   The physical or logical warehouse where this location is 
located. 

Zone     Area within the warehouse where this location is located 
or defined to be a part of. 

City     The “City” is additional, optional information about the 
location. If a “City” is not entered when the Location is 
created it will be blank.  

State     The “State” is additional, optional information about the 
location. If a “State” is not entered when the Location is 
created it will be blank.  

Zip      The “Zip” is additional, optional information about the 
location. If a “Zip” is not entered when the Location is 
created it will be blank.  

Usage     Defines how this location is to be used. A dropdown is 
provided with these values: “Pallet”, “Bulk”, “Replenish”, 
“Packing”, “Receiving”, “Staging”, “Shipping”.  

Environment   Indicates any special environmental considerations for 
this location. A dropdown list of values is provided for 
your convenience. You can use those values or define 
your own using the "Dropdown Control" screen.  Some 
examples of Environments include: “Refrigerated”, 
“Heated”, and “Clean Room”. 
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Constraint    Indicates any special constraints for this location. A 
dropdown list of values is provided for your convenience. 
You can use those values or define your own using the 
"Dropdown Control" screen.  Some examples of 
Constraints include: “Lift Truck” and “High Lift”. 

Max Pallets   The maximum number of standard size pallets that can 
be stored in this location. 

MSP     Indicates if this location is to be used for planning 
purposes in Material Scheduling (not used unless 
TFG4000 Material Scheduling is installed) 

 
Message Line 
 

Message   Displays information about the current status of the screen. 

 
Accessing the Location Definition Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Location Definition”.  The Location Definition screen is displayed. 
 
 3. If there is a location in the “Location” field, the data for that location is displayed 

on the main screen. 
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Using the Location Definition Screen  
 
Use these procedures to erase the screen, display, add, update, delete, display the 
previous, and display the next location. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Displaying an Existing Location 
 
To display a Location, perform the following steps: 
 
 1. Enter a location in the “Location” field. 
 
 2. Click the Open (Display) button  located on the toolbar or hit the Enter key. 
 
 3. The location data is displayed on the main screen. 
 
  -or- 
 
 1. Use one of the Search buttons  provided next to various fields on the screen to 

select a location. 
 
 2. Double-click on the “Location” you would like to display in the “Search” screen 

table. 
 
 3. The location data is displayed on the main screen. 
 
Adding a New Location 
 
To add a location, perform the following steps: 
 
 1. Click the Erase button  located on the toolbar to clear the screen. 
 
 2. Enter a location in the “Location” field. It can be any combination of numbers and 

letters. 
 

3. Enter data in any of the other fields you desire, these fields are optional. 
 
 4. When done, click the Save button  located on the toolbar. 
 
  -or- 
 
 1. Display an existing location.  See “Displaying an Existing Location” above. 
 
 2. Enter a new location in the “Location” field and change any of the fields you 

desire.  
 
 3. When done, click the Save button  located on the toolbar. 
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 Tip: The second procedure above can be used to copy location data to a new 

location. 
 
Updating an Existing Location 
 
To update an existing location, perform the following steps: 
 
 1. Display the location data you wish to change.  See “Displaying an Existing 

Location” above. 
 

2. Change the desired information on the screen. 
 
 3. When done, click the Save button  located on the toolbar.  
 
Deleting an Existing Location 
 
To delete an existing location, perform the following steps: 
  
 1. Display the location data you wish to delete.  See “Displaying an Existing 

Location” above. 
 

 2. Click the Delete button  located on the toolbar.   
 
 3. Click the “Yes” button on the “Confirm Action” pop up message.  If you do not 

want to delete the location click “No” on the “Confirm Action” pop up message. 
 
 Note: Once a location is deleted, it can no longer be displayed or updated. 
 
Displaying the Previous Location 
 
To display the location that precedes the one currently displayed, perform the following 
steps: 
 
 1. Click the Previous button  located on the toolbar. 
  
 2. The previous location data is displayed on the main screen. 
 
Displaying the Next Location 
 
To display the location that follows the one currently displayed, perform the following steps: 
 
 1. Click the Next button  located on the toolbar. 
 
 2. The next location data is displayed on the main screen. 
 
 Tip: You can use the Next button as a convenient way to locate the first record in 

the database.  Start by erasing the screen using the Erase button  or 
blanking out the “Location” field, then click the Next button . 
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Location Summary Screen 
 
The location summary screen allows you to display a list of inventory location definitions 
based on selection criteria entered. 
 
Selection Criteria Group 
 
Field     Explanation 
 
Location    Field for entering all or part of a location name to select the 

locations to be displayed in the Location table. Leave this field 
blank to select all locations. 

 
Type     This field is for selecting what types of locations are to be 

displayed in the Location table. Leave this field blank to select 
all types of locations. 

 
Usage     Field for selecting locations based on usage. Leave this field 

blank to select locations with all type of usage. 
 
Status     Field for selecting locations based on status. Leave this field 

blank to select locations with any status. 
 
Warehouse   Field for selecting locations based on the warehouse they are 

in. Leave this field blank to select locations in any warehouse. 
 
Zone     Field for selecting locations based on the zone they are in. 

Leave this field blank to select locations in any zone. 
 
Number of Rows to Display Controls the number of database rows to retrieve during the 

query.  The default value is 30.  The more rows retrieved, the 
longer it takes the query to complete.  Use the selection criteria 
to help control the number of rows retrieved. 

 
Location Table (Location tab) 
 
Column    Explanation 
 
Row     The line number of the row in the table. 

Location    Identification of the place where inventory may be 
stored.  

Type      Information indicating the type of “Location”. Some 
examples of Location Types include: WIP Stores, 
Inventory, Finished, Warehouse and Tool Crib. 

Location Status  Information indicating the status of the Location: 
“Active”, “Inactive”, “Hold”, or “Quarantine”. 

Usage     Defines how this location is to be used. Some examples 
of usage type are: “Pallet”, “Bulk”, “Replenish”, 
“Packing”, “Receiving”, “Staging”, and “Shipping”.  
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Constraint    Indicates any special constraints for this location. Some 
examples of Constraints include: “Lift Truck” and “High 
Lift”. 

Environment   Indicates any special environmental considerations for 
this location. Some examples of Environments include: 
“Refrigerated”, “Heated”, and “Clean Room”. 

Maximum Pallets  The maximum number of pallets that can be stored in 
this location. 

 
Location Table (Address tab) 
 
Column    Explanation 
 
Row     The line number of the row in the table. 

Location    Identification of the place where inventory may be 
stored.  

Location City   City where the location is located.  

Location State  State where the location is located.  

Location Zip   Zip code where the location is located.  

MSP     Indicates if this location is to be used for planning 
purposes in Material Scheduling (not used unless 
TFG4000 Material Scheduling is installed) 

 
Location Table (Description tab) 
 
Column    Explanation 
 
Row     The line number of the row in the table. 

Location    Identification of the place where inventory may be 
stored.  

Location Description  Brief description of the location. 

Warehouse   The physical or logical warehouse where this location is 
located. 

Zone     Area within the warehouse where this location is located 
or defined to be a part of. 

Message Line 
 

Message   Displays information about the current status of the screen. 
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Accessing the Location Summary Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Location Control”.  The Location screen is displayed. 
 
 3. If there is a location in the “Location” field, the data for that location is displayed 

on the main screen. 
 
 4. Click “Location Summary”.  The Location Summary screen is displayed. 
 
 5. If there is a location in the “Location” field, the data for that location is displayed 

on the main screen. 
 
 
Using the Location Summary Screen  
 
Use the following procedures to display an inventory location summary list. 
 
Displaying Inventory Locations 
 
Perform the following steps to display inventory locations: 
 
 1. Enter all or part of a location name in the “Location” selection criteria field, 

and/or select a type in the “Type” selection criteria field from the dropdown, 
and/or select a usage type in the “Usage” selection criteria field from the 
dropdown, and/or select a status in the “Status” selection criteria field from the 
dropdown, and/or enter all or part of a warehouse in the “Warehouse” selection 
criteria field, and/or 

  enter all or part of a zone in the “Zone” selection criteria field. 
 
 2. Click the Open (Display) button  located on the toolbar. 
 
Location Summary Reports 
 
The Location Summary screen has the following report available: 
 
 Location Summary Report 
 Basically the same information displayed on the Location Summary screen. 
 
For more information about viewing, modifying, and printing reports, see “Working with 
Reports” in the “Using TFG4000” section of this manual. 
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Location Generation Screen 
 
The location control screen allows you to enter various parameters then generate location 
definitions using those parameters. The parameters are divided into five sections which 
contain six characters each.  
 
The starting location parameters are used to determine the first location to be generated 
and the ending location parameters are used to determine the last location generated.  
 
Combinations of the parameters are used to determine the location names that will be 
generated. The generator examines the parameters entered and attempts to increment 
numeric values in the parameters based on the start and end patterns to generate the new 
location names.  
 
When the parameters are entered and generation is requested, the system will verify the 
parameters entered to determine if locations can be generated from the information 
entered, and if so, how many locations would be generated. If there is an error in any of the 
parameters, you will receive a message explaining the problem. If the parameters are good, 
you will receive a message explaining how many locations will be generated and you will 
have the option of continuing with the generation or canceling the generation process. Click 
“Yes” to continue the process, “No” to cancel the process.  
 
Only the Starting Location (First) parameter and Ending Location (First) parameter are 
required. 
 
Generation Parameters 
 
Field     Explanation 
 
Starting Location (First) Field for entering the first part of the location to be used when 

locations are generated. Up to six characters may be entered 
here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Ending 
Location (First). 

 
Starting Location (Second) Field for entering the second part of the location to be used 

when locations are generated. Up to six characters may be 
entered here with any combination of letters and numbers. The 
pattern used here must be consistent with the pattern used in 
Ending Location (Second). 

 
Starting Location (Third) Field for entering the third part of the location to be used when 

locations are generated. Up to six characters may be entered 
here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Ending 
Location (Third). 

 
Starting Location (Fourth) Field for entering the fourth part of the location to be used 

when locations are generated. Up to six characters may be 
entered here with any combination of letters and numbers. The 
pattern used here must be consistent with the pattern used in 
Ending Location (Fourth). 

 
Starting Location (Fifth) Field for entering the fifth part of the location to be used when 

locations are generated. Up to six characters may be entered 
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here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Ending 
Location (Fifth). 

 
Ending Location (First) Field for entering the first part of the location to be used when 

locations are generated. Up to six characters may be entered 
here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Starting 
Location (First). 

 
Ending Location (Second) Field for entering the second part of the location to be used 

when locations are generated. Up to six characters may be 
entered here with any combination of letters and numbers. The 
pattern used here must be consistent with the pattern used in 
Starting Location (Second). 

 
Ending Location (Third) Field for entering the third part of the location to be used when 

locations are generated. Up to six characters may be entered 
here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Starting 
Location (Third). 

 
Ending Location (Fourth) Field for entering the fourth part of the location to be used 

when locations are generated. Up to six characters may be 
entered here with any combination of letters and numbers. The 
pattern used here must be consistent with the pattern used in 
Starting Location (Fourth). 

 
Ending Location (Fifth) Field for entering the fifth part of the location to be used when 

locations are generated. Up to six characters may be entered 
here with any combination of letters and numbers. The pattern 
used here must be consistent with the pattern used in Starting 
Location (Fifth). 

 
Generation Data 
 
Field     Explanation 
 
Description   Brief description of the location. 

Warehouse   The physical or logical warehouse where this location is 
located. 

Zone     Area within the warehouse where this location is located 
or defined to be a part of. 

City     The “City” is additional, optional information about the 
location. If a “City” is not entered when the Location is 
created it will be blank.  

State     The “State” is additional, optional information about the 
location. If a “State” is not entered when the Location is 
created it will be blank.  
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Zip      The “Zip” is additional, optional information about the 
location. If a “Zip” is not entered when the Location is 
created it will be blank.  

Type      Information indicating the type of “Location”. Some 
examples of Location Types include: WIP Stores, 
Inventory, Finished, Warehouse and Tool Crib. 

Status     Information indicating the status of the Location: 
“Active”, “Inactive”, “Hold”, or “Quarantine”. 

Environment   Indicates any special environmental considerations for 
this location. A dropdown list of values is provided for 
your convenience. You can use those values or define 
your own using the "Dropdown Control" screen.  Some 
examples of Environments include: “Refrigerated”, 
“Heated”, and “Clean Room”. 

Usage     Defines how this location is to be used. A dropdown is 
provided with these values: “Pallet”, “Bulk”, “Replenish”, 
“Packing”, “Receiving”, “Staging”, “Shipping”.  

Constraint    Indicates any special constraints for this location. A 
dropdown list of values is provided for your convenience. 
You can use those values or define your own using the 
"Dropdown Control" screen.  Some examples of 
Constraints include: “Lift Truck” and “High Lift”. 

Max Pallets   The maximum number of standard size pallets that can 
be stored in this location. 

MSP     Indicates if this location is to be used for planning 
purposes in Material Scheduling (not used unless 
TFG4000 Material Scheduling is installed) 

 
Message Line 
 

Message    Displays information about the current status of the 
screen. 
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Accessing the Location Generation Screen 
 
 1. Click the plus (“+”) next to “Common Applications” or double-click  “Common 

Applications” in the “NavTree”.   
 
  -or- 
 

Click on the “View” menu.  Select “Goto Screen”, then select “Common 
Applications”. 

 
 2. Click “Location Control”.  The Location screen is displayed. 
 
 3. If there is a location in the “Location” field, the data for that location is displayed 

on the main screen. 
 
 4. Click “Location Generation”.  The Location Generation screen is displayed. 
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Using the Location Generation Screen  
 
Use these procedures to erase the screen and generate new location definitions. 
 
Erasing the Screen 
 
To erase the data from the screen click the Erase button  located on the toolbar. 
 
Note: Erasing the screen does not cause any data to be lost; it is merely a way to clean the 

screen in preparation for another operation. 
 
Generating New Location Definitions 
 
To generate new location definitions, perform the following steps: 
 
 1. Enter the first part of the starting location in the “Starting Location” “First” field. 
 
 2. Enter the first part of the ending location in the “Ending Location” “First” field. 

Make sure that the pattern entered here is consistent with the pattern entered in 
the “Starting Location” “First” field. 

 
 3. Enter any of the other parts of the location generation parameters as needed 

making sure that the pattern in the Starting fields are consistent with the 
patterns in the corresponding ending fields. 

 
 4. Enter/select generation data in the lower half of the screen. This data will be 

applied to each location you generate. 
 

 5. Click the Generate Locations button  located on the toolbar. 
 
 6. If there are any problems with the parameters you will receive a message 

explaining the problem. If the parameters are valid, you will receive a message 
explaining how many locations will be generated and you will be given an 
opportunity to continue the generation process or cancel the process. Click “Yes” 
to continue, “No” to cancel. 

 
 7. If you clicked “Yes” to continue the generation process the new locations will be 

generated and you can view them with the Location Control screen or the 
Location Summary screen. 

 
Examples: 
 
    First  Second Third  Fourth Fifth 
Starting Location 1 
Ending Location 5 
 
The parameters above will generate the following locations: 1, 2, 3, 4, and 5 
 
    First  Second Third  Fourth Fifth 
Starting Location Stock1 
Ending Location Stock5 
 
The parameters above will generate the following locations: Stock1, Stock2, Stock3, Stock4, 
and Stock5 



 

 62 

 
    First  Second Third  Fourth Fifth 
Starting Location Stock1  Bin001 
Ending Location Stock5  Bin010 
 
The parameters above will generate the following locations: Stock1Bin001, Stock1Bin002… 
Stock1Bin010… Stock5Bin001… Stock5Bin010 
 
    First  Second Third  Fourth Fifth 
Starting Location Stock1  Bin001 
Ending Location 5Stock  Bin010 
 
The parameters above will cause an error message indicating that the pattern in the ending 
location is not consistent with the pattern in the starting location in the first parameter 
position. 
 
    First  Second Third  Fourth Fifth 
Starting Location Stock1  Bin010 
Ending Location Stock5  Bin001 
 
The parameters above will cause an error message indicating that the pattern in the ending 
location is less than the pattern in the starting location in the second parameter position. 
 
    First  Second Third  Fourth Fifth 
Starting Location Stock1  Row001 Aisle1  Shelf1 Bin001 
Ending Location Stock1  Row001 Aisle1  Shelf1 Bin999 
 
The parameters above will generate the following locations: 
Stock1Row001Aisle1ShelfBin001, Stock1Row001Aisle1ShelfBin002… 
Stock1Row001Aisle1ShelfBin999 
 
    First  Second Third  Fourth Fifth 
Starting Location Stock1  R1  A1  S1 B1 
Ending Location Stock1  R1  A1  S10 B5 
 
The parameters above will generate the following locations: Stock1R1A1S1B1, 
StockR1A1S1B2… Stock1R1A1S1B5… Stock1R1A1S2B1… Stock1R1A1S10B1… 
Stock1R1A1S10B5 
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Advanced Installation 
 
TFG4000 provides some advanced installation functionality such as: font sizes, system 
variables, server start up options, BAT file options for single user and multi user modes. 
 
Please refer to the System Administration User Guide for more information. 
 
 

Documentation 
 
TFG4000 documentation (in PDF format) is available online at www.tfg4000.com, through 
the “Documentation” menu on each screen, or from the Windows “Start” menu.  Simply 
click “Start”, then “Programs”, then “TFG4000 V1.4", and then “Documentation”. 
 
Note: PDF files require Adobe® Acrobat® Reader.  The reader is available at 

www.adobe.com free of charge. 
 
 

Registration 
 
Quick & Easy Online: After installation, you can go to our web page at www.tfg4000.com 
to register the product.  Click on “Register” and follow the instructions. 
 
 

Suggestions 
 
We are eager to improve TFG4000, and we urge you to tell us what you think of the 
software and how it could be improved to better suit your needs.  We have taken many 
suggestions from our customers and incorporated them into our products.  If you have 
suggestions or comments, please send an e-mail to tfg4000@fredrickgroup.com.  We want 
to hear from you! 
 
 

Services 
 
The Fredrick Group, Inc. offers assistance in data conversion.  For more information, contact 
The Fredrick Group, Inc. directly by either: 
 
E-mail  Send an e-mail to tfg4000@fredrickgroup.com, with ‘Services’ in the subject line.  
 
Phone  Call 770-844-8516 between 8:30 AM - 5:00 PM ET. 
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Support 
 
Note: You must be registered in order to receive support. 
 
Initial Installation Support 
 
The Fredrick Group, Inc. provides free initial installation support via e-mail.  Installation 
support is available for 30 days, and is activated when you send your first message.  You 
may also receive installation support by calling, but you must pay the cost of the call.  
Technicians are available on a limited basis Monday through Friday from 8:30 am to 5:00 
pm Eastern time.  The TFG4000 product technical support number is 770-844-8516. 
 
Pay-As-You-Go Support 
 
Additional fee-based support is available.  You pay the cost of the call plus an additional fee.  
Credit card information must be provided and confirmed before a call is accepted.  
Technicians are available on a limited basis Monday through Friday from 8:30 am to 5:00 
pm Eastern time. The TFG4000 product technical support number is 770-844-8516. 
 
Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details. 
 
Other Support Options  
 
Other support options are available. 
 
Contact The Fredrick Group, Inc. at tfg4000@fredrickgroup.com for more details. 
 
Note: Support plans and fees are subject to change without notice. 
 
 

TFG4000 Software Series  
 
You can obtain the following TFG4000 applications by visiting your nearest retailer: 
 
 Inventory Management 
 Job Order Management 
 Sales Order Management 
 Purchasing Management 
 
For more information go to www.tfg4000.com. 
 


